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/*****************************************************/ 

// NAMA    :Muchammad Najiulloh Alamuddin Romdhoni 

// NIM     :115060307111016 

// JUDUL   :Pengendalian Kecepatan Propeller pada Kesetimbangan Bicopter 

menggunakan Kontroler Logika Fuzzy 

/****************************************************/ 

#include <FuzzyRule.h> 

#include <FuzzyComposition.h> 

#include <Fuzzy.h> 

#include <FuzzyRuleConsequent.h> 

#include <FuzzyOutput.h> 

#include <FuzzyInput.h> 

#include <FuzzyIO.h> 

#include <FuzzySet.h> 

#include <FuzzyRuleAntecedent.h> 

 

int AnFback = A0; 

int outPWM = 13; 

int d, spoint, sudut, e, e_old, ce; 

 

 

// class fuzzy 

Fuzzy* fuzzy = new Fuzzy(); 

 

// fuzzyset error 

FuzzySet* e_mn = new FuzzySet(-45, -45, -30, -15); 

FuzzySet* e_n = new FuzzySet(-30, -15, -15, 0); 

FuzzySet* e_z = new FuzzySet(-15, 0, 0, 15); 

FuzzySet* e_p = new FuzzySet(0, 15, 15, 30); 

FuzzySet* e_mp = new FuzzySet(15, 30, 45, 45); 

 

// fuzzyset change error 

FuzzySet* ce_mn = new FuzzySet(-45, -45, -30, -15); 

FuzzySet* ce_n = new FuzzySet(-30, -15, -15, 0); 
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FuzzySet* ce_z = new FuzzySet(-15, 0, 0, 15); 

FuzzySet* ce_p = new FuzzySet(0, 15, 15, 30); 

FuzzySet* ce_mp = new FuzzySet(15, 30, 45, 45); 

 

// fuzzyset singleton output 

FuzzySet* o_vlp = new FuzzySet(0, 0, 0, 0); 

FuzzySet* o_lp = new FuzzySet(64, 64, 64, 64); 

FuzzySet* o_mp = new FuzzySet(128, 128, 128, 128); 

FuzzySet* o_hp = new FuzzySet(192, 192, 192, 192); 

FuzzySet* o_fp = new FuzzySet(255, 255, 255, 255); 

 

 

int ReadSudut() 

{ 

  d = analogRead(AnFback); 

  if (d == 512) { sudut = 0; } 

  if (sudut < 512) { sudut = -( d/512)*30; } 

  if (sudut > 512) { sudut = (d/512)*30; } 

  return(sudut); 

} 

 

 

void setup(){ 

  Serial.begin(9600); 

 

  e =0; ce = 0; 

  // fuzzy input error 

  FuzzyInput* error = new FuzzyInput(1); 

  error->addFuzzySet(e_mn); 

  error->addFuzzySet(e_n); 

  error->addFuzzySet(e_z); 

  error->addFuzzySet(e_p); 

  error->addFuzzySet(e_mp);  

  fuzzy->addFuzzyInput(error);   
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  // fuzzy input change error 

  FuzzyInput* cerror = new FuzzyInput(2); 

  cerror->addFuzzySet(ce_mn); 

  cerror->addFuzzySet(ce_n); 

  cerror->addFuzzySet(ce_z); 

  cerror->addFuzzySet(ce_p); 

  cerror->addFuzzySet(ce_mp);  

  fuzzy->addFuzzyInput(cerror);     

 

  // fuzzy output  

  FuzzyOutput* output = new FuzzyOutput(1); 

  output->addFuzzySet(o_vlp); 

  output->addFuzzySet(o_lp); 

  output->addFuzzySet(o_mp); 

  output->addFuzzySet(o_hp); 

  output->addFuzzySet(o_fp);  

  fuzzy->addFuzzyOutput(output);    

 

  // consequent 

  FuzzyRuleConsequent* thenVLP = new FuzzyRuleConsequent(); 

  thenVLP->addOutput(o_vlp); 

  FuzzyRuleConsequent* thenLP = new FuzzyRuleConsequent(); 

  thenLP->addOutput(o_lp); 

  FuzzyRuleConsequent* thenMP = new FuzzyRuleConsequent(); 

  thenMP->addOutput(o_mp);     

  FuzzyRuleConsequent* thenHP = new FuzzyRuleConsequent(); 

  thenHP->addOutput(o_hp);  

  FuzzyRuleConsequent* thenFP = new FuzzyRuleConsequent(); 

  thenFP->addOutput(o_fp); 

 

  // antecedent baris 1  

  FuzzyRuleAntecedent* antecedent1_1 = new FuzzyRuleAntecedent(); 

  antecedent1_1->joinWithAND(e_mn, ce_mn); 
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  FuzzyRuleAntecedent* antecedent1_2 = new FuzzyRuleAntecedent(); 

  antecedent1_2->joinWithAND(e_n, ce_mn);  

  FuzzyRuleAntecedent* antecedent1_3 = new FuzzyRuleAntecedent(); 

  antecedent1_3->joinWithAND(e_z, ce_mn); 

  FuzzyRuleAntecedent* antecedent1_4 = new FuzzyRuleAntecedent(); 

  antecedent1_4->joinWithAND(e_p, ce_mn); 

  FuzzyRuleAntecedent* antecedent1_5 = new FuzzyRuleAntecedent(); 

  antecedent1_5->joinWithAND(e_mp, ce_mn);       

  // antecedent baris 2 

  FuzzyRuleAntecedent* antecedent2_1 = new FuzzyRuleAntecedent(); 

  antecedent2_1->joinWithAND(e_mn, ce_n); 

  FuzzyRuleAntecedent* antecedent2_2 = new FuzzyRuleAntecedent(); 

  antecedent2_2->joinWithAND(e_n, ce_n);  

  FuzzyRuleAntecedent* antecedent2_3 = new FuzzyRuleAntecedent(); 

  antecedent2_3->joinWithAND(e_z, ce_n); 

  FuzzyRuleAntecedent* antecedent2_4 = new FuzzyRuleAntecedent(); 

  antecedent2_4->joinWithAND(e_p, ce_n); 

  FuzzyRuleAntecedent* antecedent2_5 = new FuzzyRuleAntecedent(); 

  antecedent2_5->joinWithAND(e_mp, ce_n);  

  // antecedent baris 3 

  FuzzyRuleAntecedent* antecedent3_1 = new FuzzyRuleAntecedent(); 

  antecedent3_1->joinWithAND(e_mn, ce_z); 

  FuzzyRuleAntecedent* antecedent3_2 = new FuzzyRuleAntecedent(); 

  antecedent3_2->joinWithAND(e_n, ce_z);  

  FuzzyRuleAntecedent* antecedent3_3 = new FuzzyRuleAntecedent(); 

  antecedent3_3->joinWithAND(e_z, ce_z); 

  FuzzyRuleAntecedent* antecedent3_4 = new FuzzyRuleAntecedent(); 

  antecedent3_4->joinWithAND(e_p, ce_z); 

  FuzzyRuleAntecedent* antecedent3_5 = new FuzzyRuleAntecedent(); 

  antecedent3_5->joinWithAND(e_mp, ce_z);  

  // antecedent baris 4 

  FuzzyRuleAntecedent* antecedent4_1 = new FuzzyRuleAntecedent(); 

  antecedent4_1->joinWithAND(e_mn, ce_p); 

  FuzzyRuleAntecedent* antecedent4_2 = new FuzzyRuleAntecedent(); 
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  antecedent4_2->joinWithAND(e_n, ce_p);  

  FuzzyRuleAntecedent* antecedent4_3 = new FuzzyRuleAntecedent(); 

  antecedent4_3->joinWithAND(e_z, ce_p); 

  FuzzyRuleAntecedent* antecedent4_4 = new FuzzyRuleAntecedent(); 

  antecedent4_4->joinWithAND(e_p, ce_p); 

  FuzzyRuleAntecedent* antecedent4_5 = new FuzzyRuleAntecedent(); 

  antecedent4_5->joinWithAND(e_mp, ce_p);  

  // antecedent baris 5 

  FuzzyRuleAntecedent* antecedent5_1 = new FuzzyRuleAntecedent(); 

  antecedent5_1->joinWithAND(e_mn, ce_mp); 

  FuzzyRuleAntecedent* antecedent5_2 = new FuzzyRuleAntecedent(); 

  antecedent5_2->joinWithAND(e_n, ce_mp);  

  FuzzyRuleAntecedent* antecedent5_3 = new FuzzyRuleAntecedent(); 

  antecedent5_3->joinWithAND(e_z, ce_mp); 

  FuzzyRuleAntecedent* antecedent5_4 = new FuzzyRuleAntecedent(); 

  antecedent5_4->joinWithAND(e_p, ce_mp); 

  FuzzyRuleAntecedent* antecedent5_5 = new FuzzyRuleAntecedent(); 

  antecedent5_5->joinWithAND(e_mp, ce_mp);    

 

 

  // rule 

  FuzzyRule* rule1_1 = new FuzzyRule(1, antecedent1_1, thenMP); 

  fuzzy->addFuzzyRule(rule1_1); 

   FuzzyRule* rule1_2 = new FuzzyRule(2, antecedent1_2, thenLP); 

  fuzzy->addFuzzyRule(rule1_2); 

  FuzzyRule* rule1_3 = new FuzzyRule(3, antecedent1_3, thenHP); 

  fuzzy->addFuzzyRule(rule1_3); 

  FuzzyRule* rule1_4 = new FuzzyRule(4, antecedent1_4, thenHP); 

  fuzzy->addFuzzyRule(rule1_4); 

  FuzzyRule* rule1_5 = new FuzzyRule(5, antecedent1_5, thenHP); 

  fuzzy->addFuzzyRule(rule1_5); 

  

  FuzzyRule* rule2_1 = new FuzzyRule(6, antecedent2_1, thenLP); 

  fuzzy->addFuzzyRule(rule2_1); 
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  FuzzyRule* rule2_2 = new FuzzyRule(7, antecedent2_2, thenMP); 

  fuzzy->addFuzzyRule(rule2_2); 

  FuzzyRule* rule2_3 = new FuzzyRule(8, antecedent2_3, thenMP); 

  fuzzy->addFuzzyRule(rule2_3); 

  FuzzyRule* rule2_4 = new FuzzyRule(9, antecedent2_4, thenHP); 

  fuzzy->addFuzzyRule(rule2_4); 

  FuzzyRule* rule2_5 = new FuzzyRule(10, antecedent2_5, thenFP); 

  fuzzy->addFuzzyRule(rule2_5); 

 

  FuzzyRule* rule3_1 = new FuzzyRule(11, antecedent3_1, thenLP); 

  fuzzy->addFuzzyRule(rule3_1); 

  FuzzyRule* rule3_2 = new FuzzyRule(12, antecedent3_2, thenMP); 

  fuzzy->addFuzzyRule(rule3_2); 

  FuzzyRule* rule3_3 = new FuzzyRule(13, antecedent3_3, thenMP); 

  fuzzy->addFuzzyRule(rule3_3); 

  FuzzyRule* rule3_4 = new FuzzyRule(14, antecedent3_4, thenMP); 

  fuzzy->addFuzzyRule(rule3_4); 

  FuzzyRule* rule3_5 = new FuzzyRule(15, antecedent3_5, thenFP); 

  fuzzy->addFuzzyRule(rule3_5); 

 

  FuzzyRule* rule4_1 = new FuzzyRule(16, antecedent4_1, thenVLP); 

  fuzzy->addFuzzyRule(rule4_1); 

   FuzzyRule* rule4_2 = new FuzzyRule(17, antecedent4_2, thenLP); 

  fuzzy->addFuzzyRule(rule4_2); 

  FuzzyRule* rule4_3 = new FuzzyRule(18, antecedent4_3, thenMP); 

  fuzzy->addFuzzyRule(rule4_3); 

  FuzzyRule* rule4_4 = new FuzzyRule(19, antecedent4_4, thenMP); 

  fuzzy->addFuzzyRule(rule4_4); 

  FuzzyRule* rule4_5 = new FuzzyRule(20, antecedent4_5, thenLP); 

  fuzzy->addFuzzyRule(rule4_5); 

 

  FuzzyRule* rule5_1 = new FuzzyRule(21, antecedent5_1, thenVLP); 

  fuzzy->addFuzzyRule(rule5_1); 

  FuzzyRule* rule5_2 = new FuzzyRule(22, antecedent5_2, thenVLP); 
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  fuzzy->addFuzzyRule(rule5_2); 

  FuzzyRule* rule5_3 = new FuzzyRule(23, antecedent5_3, thenLP); 

  fuzzy->addFuzzyRule(rule5_3); 

  FuzzyRule* rule5_4 = new FuzzyRule(24, antecedent5_4, thenLP); 

  fuzzy->addFuzzyRule(rule5_4); 

  FuzzyRule* rule5_5 = new FuzzyRule(25, antecedent5_5, thenMP); 

  fuzzy->addFuzzyRule(rule5_5); 

} 

 

void loop(){ 

  e = -ReadSudut(); 

  ce = e - e_old;  

  fuzzy->setInput(1, e); 

  fuzzy->setInput(2, ce); 

  fuzzy->fuzzify(); 

  float output = fuzzy->defuzzify(1); 

  analogWrite(outPWM, output); 

  e_old = e; 

  delay(100); 

} 
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EMAX    Brushless Motors  
See – www.emax.modeldiy.com  

Product Range and  

Specifications-  

EMAX BL1812 / BL1806  

Very Lightweight - Ideal for Indoor Foamys :-  

BL1812 – Weight:   28g (including the firewall),    KV=1800   

Battery (LiPo)        Current           Prop            Thrust           rpm  

7.4V                        10A             9X4.5           220 g               

11.1V                      13A             10X4.7         380 g  

BL1806 – Weight:   18g (including the firewall),    KV=1650   
Battery (LiPo)        Current           Prop            
Thrust           rpm 7.4V                        6.0 A             
7X5              180 g           6750 11.1V                      
10 A              7X5              240 g           
7550  
 

EMAX BL2215 
Light weight (60g) brushless motors with rotating case suitable for all models of 300-400 size As 
a result of using the latest ferromagnetic materials the EMAX 2215/xx motors offer extremely 

high efficiency and high load capability for their weight. Includes all mounting hardware, 3 gold 

connectors and Prop adapter.  

 

BL221/25 KV= 950 Performance Chart 

Model Voltage Propeller RPM Max Current Max Thrust 

BL2215/25 12.0V 10X5(Thin) 8180 14A 850g 

BL2215/25 12.0V 11X7(Thin) 6280 18A 905g 

BL2215/25 12.0V 1047GWS 7200 16.5A 930g 

BL2215/25 12.0V 10X4.7(Slow) 7250 16.5A 950g 

BL2215/25 12.0V 1060GWS 7800 15A 850g 

BL2215/25 12.0V 9X4(Slow) 8750 12A 810g 

 

 
    

 
800g./28oz. 3S 1800mAH EMAX 18A 9X4.7(SLOW) 

 
500g./18oz. 3S 1800mAH EMAX 18A 10X4.7(Slow) 

 
600g./14oz. 3S 1800mAH EMAX 18A 10X5(Thin) 
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BL221/25 KV= 950 Performance Chart 

Model Voltage Propeller RPM Max Current 
Max 

Thrust 

BL2215/20 12.0V 10X4(Slow) 7250 19A 1040g 

BL2215/20 12.0V 9X4(Slow) 9900 17.5A 1020g 

BL2215/20 10.9V 10X5(Thin) 9350 24.5A 1200g 

BL2215/20 10.9V 8X3(Slow) 11050 16.5A 960g 

 
 

 
    

 
1000g./35.2oz. 3S 1800mAH EMAX 25A 10X5(Thin) 

 
600g./21oz. 3S 1800mAH EMAX 25A 10X4.7(Slow) 

 
800g./28oz. 3S 1800mAH EMAX 25A 10X5(Thin) 

 

 

Specifications 

No. Of cells 2-3x Li-Poly 
Max. efficiency 82% 

Max. efficiency current 8 - 13 A (>75%) 
No load current / 10 V 0,5 A 

Current capacity 
2215/25 15 A/60s 
2215/20 20 A/60s 

Internal Resistance 275 mohm 

Dimensions 28x32 mm 

Shaft diameter 3 mm 
Weight 59 g/2.08oz. 

Recommended model weight 300-800 g 

Recommended prop without gearbox 8"-10" 
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Lipo Batteries – High Quality – Economical Power Source 
 

Type Model Specifications for 20C 
Dimensions 
(L x W x D) 

Weight 

LP20-800-2 20C, 800 mAh - 2s1p - 2 cell - 7.4V 
62X35X11mm 
(2.44X1.37X0.4in) 

1.24oz 
(35g) 

LP20-800-3 20C, 800 mAh - 3s1p - 3 cell - 11.1V 
62X35X14mm 
(2.44X1.37X0.5in) 

1.76oz 
(50g) 

LP20-1000-2 20C, 1000 mAh - 2s1p - 2 cell - 7.4V 
62X35X11mm 

(2.44X1.37X0.4in) 
1.87oz 

(53g) 

LP20-1000-3 20C, 1000 mAh - 3s1p - 3 cell - 11.1V 
62X35X11mm 

(2.44X1.37X0.4in) 

2.75oz 

(78g) 

LP20-1300-2 20C, 1300 mAh - 2s1p - 2 cell - 7.4V 
80X32X11mm 

(3.15X1.26X0.4in) 
2.33oz 

(66g) 

LP20-1300-3 20C, 1300 mAh - 3s1p - 3 cell - 11.1V 
80X32X15mm 

(3.15X1.26X0.5in) 
3.42oz 

(97g) 

LP20-1600-2 20C, 1600 mAh - 2s1p - 2 cell - 7.4V 
96X34X11mm 
(3.77X1.33X0.4in) 

3.14oz 
(89g) 

LP20-1600-3 20C, 1600 mAh - 3s1p - 3 cell - 11.1V 
96X34X16mm 

(3.77X1.33X0.6in) 
4.62oz 

(131g) 

LP20-1800-3 20C, 1800 mAh - 3s1p - 3 cell - 11.1V 
96X34X17mm 

(3.77X1.33X0.6in) 
5.86oz 

(166g) 

LP15-2250-3 15C, 2250 mAh - 3s1p - 3 cell - 11.1V 
96X34X18mm 

(3.77X1.33X0.7in) 
5.86oz 

(166g) 
 
 
 

  All EMAX ESC’s have the following Features and Programming Functions- 
 
Safety Arming Feature: Regardless the Throttle Stick position, the motor will not run 
after the battery is connected. This will avoid any injuries. 
 
Throttle Calibration: Throttle range can be configured to provide best throttling linearity, 
fully compatible with all available transmitters. 
 
Programmable Features ( Program card Available ) - 
 
Brake Settings : brake enabled / brake disabled, default is brake disabled 
 
Battery Type : Li-xx(Li-ion or Li-poly) / Ni-xx(NiMh or Nicd), default is Li-xx. 
 

 
 
Low Voltage Protection Mode (Cutoff Mode) : power reducing / power cutoff, default is 
power reducing. 
 
Low Voltage Protection Threshold (Cutoff Threshold) : low / medium / high, default is 
medium cutoff voltage. For Li-xx battery, number of battery cells are judged automatically, 
low / medium / high cutoff voltage for each cell are: 2.6V/2.85V/3.1V. For example: 3 Cells 
Li-Poly, when medium cutoff voltage is set, the cutoff voltage is: 2.85*3=8.55V. For Ni-xx 
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battery, low / medium / high cutoff voltages are 0/45%/60% of the startup voltage. (0% 
means the low voltage cutoff function is disabled). For example: 10 cells NiMH battery, 
fully charged voltage is 1.44*10=14.4V, when medium cutoff voltage is set, the cutoff 
voltage is : 14.4*45%=6.5V 
 
Startup mode: normal / soft / super-soft, default is normal startup. 
 
Timing: low / medium / high, default is medium timing. In normal cases, low timing can be 
used for most motors. But for high efficiency, we recommend the Low timing for 2 poles 
motor and Medium timing for 6 poles and above. For higher speed, High timing could be 
used. 
 
ESC. Protection Features: Low-voltage cutoff protection / over-heat protection / throttle 
signal lost protection . 
 
Design Features - Capacitors with extremely low resistance used on voltage input  
ection, this will improve the ability to prevention unwanted RF Noise / Interference during 
flying. Extreme low resistance, super high current endurance. Microprocessor and BEC 
use separate voltage regulator IC, with good antijamming capabilities. 
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The Arduino Uno is a microcontroller board based on the ATmega328 (datasheet). 
It has 14 digital input/output pins (of which 6 can be used as PWM outputs), 6 analog 
inputs, a 16 MHz crystal oscillator, a USB connection, a power jack, an ICSP header, 
and a reset button. It contains everything needed to support the microcontroller; 
simply connect it to a computer with a USB cable or power it with a AC-to-DC 
adapter or battery to get started. The Uno differs from all preceding boards in that it 
does not use the FTDI USB-to-serial driver chip. Instead, it features the Atmega8U2 
programmed as a USB-to-serial converter. 
 
"Uno" means one in Italian and is named to mark the upcoming release of Arduino 
1.0. The Uno and version 1.0 will be the reference versions of Arduno, moving 
forward. The Uno is the latest in a series of USB Arduino boards, and the reference 
model for the Arduino platform; for a comparison with previous versions, see the 
index of Arduino boards 
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EAGLE files: arduino-duemilanove-uno-design.zip Schematic: arduino-uno-schematic.pdf 
 

 
 
Microcontroller       ATmega328 
Operating Voltage      5V 
Input Voltage (recommended)    7-12V 
Input Voltage (limits)      6-20V 
Digital I/O Pins       14 (of which 6 provide PWM 
output) 
Analog Input Pins      6 
DC Current per I/O Pin     40 mA 
DC Current for 3.3V Pin     50 mA 
Flash Memory       32 KB of which 0.5 KB used by 

bootloader 
SRAM         2 KB 
EEPROM        1 KB 
Clock Speed       16 MHz 
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The Arduino Uno can be powered via the USB connection or with an external power 
supply. The power source is selected automatically. 
 
External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) 
or battery. The adapter can be connected by plugging a 2.1mm center-positive plug 
into the board's power jack. Leads from a battery can be inserted in the Gnd and 
Vin pin headers of the POWER connector. 
 
The board can operate on an external supply of 6 to 20 volts. If supplied with less 
than 7V, however, the 5V pin may supply less than five volts and the board may be 
unstable. If using more than 12V, the voltage regulator may overheat and damage 
the board. The recommended range is 7 to 12 volts. 
 
The power pins are as follows: 
 

VIN. The input voltage to the Arduino board when it's using an external 
power source (as opposed to 5 volts from the USB connection or other 
regulated power source). You can supply voltage through this pin, or, if 
supplying voltage via the power jack, access it through this pin. 

5V. The regulated power supply used to power the microcontroller and 
other components on the board. This can come either from VIN via an on-
board regulator, or be supplied by USB or another regulated 5V supply. 




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3V3. A 3.3 volt supply generated by the on-board regulator. Maximum 
current draw is 50 mA. 

GND. Ground pins. 

 

 
 
The Atmega328 has 32 KB of flash memory for storing code (of which 0,5 KB is 
used for the bootloader); It has also 2 KB of SRAM and 1 KB of EEPROM (which 
can be read and written with the EEPROM library). 
 

 
 
Each of the 14 digital pins on the Uno can be used as an input or output, using 
pinMode(), digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each 
pin can provide or receive a maximum of 40 mA and has an internal pull-up resistor 
(disconnected by default) of 20-50 kOhms. In addition, some pins have specialized 
functions: 
 

Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL 
serial data. TThese pins are connected to the corresponding pins of the 
ATmega8U2 USB-to-TTL Serial chip . 

External Interrupts: 2 and 3. These pins can be configured to trigger an 
interrupt on a low value, a rising or falling edge, or a change in value. See 
the attachInterrupt() function for details. 

PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the 
analogWrite() function. 

SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI 
communication, which, although provided by the underlying hardware, is not 
currently included in the Arduino language. 

LED: 13. There is a built-in LED connected to digital pin 13. When the pin 
is HIGH value, the LED is on, when the pin is LOW, it's off. 

 
The Uno has 6 analog inputs, each of which provide 10 bits of resolution (i.e. 1024 
different values). By default they measure from ground to 5 volts, though is it 
possible to change the upper end of their range using the AREF pin and the 
analogReference() function. Additionally, some pins have specialized functionality: 
 

I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the 
Wire library. 

 
There are a couple of other pins on the board: 
 

AREF. Reference voltage for the analog inputs. Used with 
analogReference(). 

Reset. Bring this line LOW to reset the microcontroller. Typically used to  
See also the mapping between Arduino pins and Atmega328 ports. 
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The Arduino Uno has a number of facilities for communicating with a computer, 
another Arduino, or other microcontrollers. The ATmega328 provides UART TTL 
(5V) serial communication, which is available on digital pins 0 (RX) and 1 (TX). An 
ATmega8U2 on the board channels this serial communication over USB and 
appears as a virtual com port to software on the computer. The '8U2 firmware uses 
the standard USB COM drivers, and no external driver is needed. However, on 
Windows, an *.inf file is required.. 
 
The Arduino software includes a serial monitor which allows simple textual data to 
be sent to and from the Arduino board. The RX and TX LEDs on the board will flash 
when data is being transmitted via the USB-toserial chip and USB connection to the 
computer (but not for serial communication on pins 0 and 1). 
 
A SoftwareSerial library allows for serial communication on any of the Uno's digital 
pins. 
 
The ATmega328 also support I2C (TWI) and SPI communication. The Arduino 
software includes a Wire library to simplify use of the I2C bus; see the 
documentation for details. To use the SPI communication, please see the 
ATmega328 datasheet. 
 

 
 
The Arduino Uno can be programmed with the Arduino software (download). 
Select "Arduino Uno w/ 
ATmega328" from the Tools > Board menu (according to the microcontroller on 
your board). For details, see the reference and tutorials. 
 
The ATmega328 on the Arduino Uno comes preburned with a bootloader that 
allows you to upload new code to it without the use of an external hardware 
programmer. It communicates using the original STK500 protocol (reference, C 
header files). 
 
You can also bypass the bootloader and program the microcontroller through the 
ICSP (In-Circuit Serial Programming) header; see these instructions for details. 
 
The ATmega8U2 firmware source code is available . The ATmega8U2 is loaded 
with a DFU bootloader, which can be activated by connecting the solder jumper on 
the back of the board (near the map of Italy) and then resetting the 8U2. You can 
then use Atmel's FLIP software (Windows) or the DFU programmer (Mac OS X 
and Linux) to load a new firmware. Or you can use the ISP header with an external 
programmer (overwriting the DFU bootloader). 
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Rather than requiring a physical press of the reset button before an upload, the 
Arduino Uno is designed in a way that allows it to be reset by software running on a 
connected computer. One of the hardware flow control lines (DTR) of the 
ATmega8U2 is connected to the reset line of the ATmega328 via a 100 nanofarad 
capacitor. When this line is asserted (taken low), the reset line drops long enough 
to reset the chip. The Arduino software uses this capability to allow you to upload 
code by simply pressing the upload button in the Arduino environment. This means 
that the bootloader can have a shorter timeout, as the lowering of DTR can be well-
coordinated with the start of the upload. 
 
This setup has other implications. When the Uno is connected to either a computer 
running Mac OS X or Linux, it resets each time a connection is made to it from 
software (via USB). For the following half-second or so, the bootloader is running 
on the Uno. While it is programmed to ignore malformed data (i.e. anything besides 
an upload of new code), it will intercept the first few bytes of data sent to the board 
after a connection is opened. If a sketch running on the board receives one-time 
configuration or other data when it first starts, make sure that the software with which 
it communicates waits a second after opening the connection and before sending 
this data. 
 
The Uno contains a trace that can be cut to disable the auto-reset. The pads on 
either side of the trace can be soldered together to re-enable it. It's labeled "RESET-
EN". You may also be able to disable the auto-reset by connecting a 110 ohm 
resistor from 5V to the reset line; see this forum thread for details. 
 

 
 
The Arduino Uno has a resettable polyfuse that protects your computer's USB ports 
from shorts and overcurrent. Although most computers provide their own internal 
protection, the fuse provides an extra layer of protection. If more than 500 mA is 
applied to the USB port, the fuse will automatically break the connection until the 
short or overload is removed. 
 

 
 
The maximum length and width of the Uno PCB are 2.7 and 2.1 inches respectively, 
with the USB connector and power jack extending beyond the former dimension. 
Three screw holes allow the board to be attached to a surface or case. Note that 
the distance between digital pins 7 and 8 is 160 mil (0.16"), not an even multiple of 
the 100 mil spacing of the other pins. 
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Arduino can sense the environment by receiving input from a variety of sensors and can 
affect its surroundings by controlling lights, motors, and other actuators. The microcontroller 
on the board is programmed using the Arduino programming language (based on Wiring) 
and the Arduino development environment (based on Processing). Arduino projects can be 
stand-alone or they can communicate with software on running on a computer (e.g. Flash, 
Processing, MaxMSP). 
 
Arduino is a cross-platoform program. You’ll have to follow different instructions for your 
personal OS. Check on the Arduino site for the latest instructions. 
http://arduino.cc/en/Guide/HomePage 
 

 

  

 
Once you have downloaded/unzipped the arduino IDE, you can Plug the Arduino to your 
PC via USB cable. 
 
 
 
 
 

http://arduino.cc/en/Guide/HomePage
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Now you’re actually ready to “burn” your first program on the arduino board. To select “blink 
led”, the physical translation of the well known programming “hello world”, select 
 
File>Sketchbook>Arduino-0017>Examples>Digital>Blink 
 
Once you have your skecth you’ll see something very close to the screenshot on the right. 
 
In Tools>Board select 
 
Now you have to go to Tools>SerialPort and select the right serial port, the one arduino is 
attached to. 
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1. Warranties 
 
1.1 The producer warrants that its products will conform to the Specifications. This warranty lasts for one 
(1) years from the date of the sale. The producer shall not be liable for any defects that are caused by neglect, 
misuse or mistreatment by the Customer, including improper installation or testing, or for any products that have 
been altered or modified in any way by a Customer. Moreover, The producer shall not be liable for any defects 
that result from Customer's design, specifications or instructions for such products. Testing and other quality 
control techniques are used to the extent the producer deems necessary. 
 
1.2 If any products fail to conform to the warranty set forth above, the producer's sole liability shall be to 
replace such products. The producer's liability shall be limited to products that are determined by the producer 
not to conform to such warranty. If the producer elects to replace such products, the producer shall have a 
reasonable time to replacements. Replaced products shall be warranted for a new full warranty period. 
 
1.3 EXCEPT AS SET FORTH ABOVE, PRODUCTS ARE PROVIDED "AS IS" AND "WITH ALL FAULTS." 
THE PRODUCER DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING 
PRODUCTS, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE 
 
1.4 Customer agrees that prior to using any systems that include the producer products, Customer will test 
such systems and the functionality of the products as used in such systems. The producer may provide 
technical, applications or design advice, quality characterization, reliability data or other services. Customer 
acknowledges and agrees that providing these services shall not expand or otherwise alter the producer's 
warranties, as set forth 
above, and no additional obligations or liabilities shall arise from the producer providing such services. 
 

1.5 The Arduinoproducts are not authorized for use in safety-critical applications where a failure of the 
product would reasonably be expected to cause severe personal injury or death. Safety-Critical Applications 
include, without limitation, life support devices and systems, equipment or systems for the operation of nuclear 

facilities and weapons systems. Arduinoproducts are neither designed nor intended for use in military or 
aerospace applications or environments and for automotive applications or environment. Customer 

acknowledges and agrees that any such use of Arduinoproducts which is solely at the Customer's risk, and 
that Customer is solely responsible for compliance with all legal and regulatory requirements in connection with 
such use. 
 
1.6 Customer acknowledges and agrees that it is solely responsible for compliance with all legal, regulatory 

and safety-related requirements concerning its products and any use of Arduinoproducts in Customer's 
applications, notwithstanding any applications-related information or support that may be provided by the 
producer. 

 
2. Indemnification 
The Customer acknowledges and agrees to defend, indemnify and hold harmless the producer from and against 
any and all third-party losses, damages, liabilities and expenses it incurs to the extent directly caused by: (i) an 
actual breach by a Customer of the representation and warranties made under this terms and conditions or (ii) 
the gross negligence or willful misconduct by the Customer. 

 
3. Consequential Damages Waiver 
In no event the producer shall be liable to the Customer or any third parties for any special, collateral, indirect, 
punitive, incidental, consequential or exemplary damages in connection with or arising out of the products 
provided hereunder, regardless of whether the producer has been advised of the possibility of such damages. 
This section will survive the termination of the warranty period. 

 
4. Changes to specifications 
The producer may make changes to specifications and product descriptions at any time, without notice. The 
Customer must not rely on the absence or characteristics of any features or instructions marked "reserved" or 
"undefined." The producer reserves these for future definition and shall have no responsibility whatsoever for 
conflicts or incompatibilities arising from future changes to them. The product information on the Web Site or 
Materials is subject to change without notice. Do not finalize a design with this information. 
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The producer of Arduinohas joined the 
Impatto Zero® policy of LifeGate.it. For each 
Arduino board produced is created / looked 
after half squared Km of Costa Rica’s forest’s. 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 


